
MLA 9th Edition Cheat Sheet

Quick Reference Guide for Students

BASIC PAPER FORMAT
Font & Size: - Times New Roman 12pt (standard) - OR any readable, professional serif
font 12pt

Margins: - 1 inch on all sides (top, bottom, left, right)

Spacing: - Double-space EVERYTHING - No extra spaces between paragraphs - No extra
spaces between heading and title - No extra spaces after title

Alignment: - Left-aligned (ragged right edge) - Do NOT justify text

Indentation: - First line of paragraphs: 0.5 inch (Tab key once) - Exception: Do NOT
indent first line after heading - Block quotes: Indent 1 inch from left margin

Page Numbers: - Top right corner of EVERY page - Last name + space + page number -
0.5 inch from top - Example: Chen 1

Title Page: - NO separate title page in MLA format - Everything begins on page 1

FIRST PAGE FORMAT
Top Right Corner (0.5 inch from top):

Last name Page#
Example: Chen 1

Top Left Corner (1 inch from top, double-spaced): 1. Your Name 2. Professor’s Name
(with title: Professor or Dr.) 3. Course Number and Name 4. Date (Day Month Year)

Title (centered, double-spaced from date): - Standard capitalization (Title Case) - NO
bold, italics, underline, or larger font - Exception: If title contains another work’s title,
format that part

Example:

Sarah Chen
Professor Jennifer Martinez
English 102: Composition and Literature
15 May 2024

        Symbolism in The Great Gatsby

Body text begins immediately below title (double-spaced)

HEADING & TITLE RULES
Heading Format: - Your full name (as you want it to appear) - Professor’s title + name
(Professor Smith, Dr. Jones) - Course number + name (ENG 101: Composition) - Date in
Day Month Year format (15 May 2024)

Date Formats:



✓ 15 May 2024
✓ 1 Jan. 2024
✗ May 15, 2024 (American format - DO NOT USE)
✗ 5/15/2024 (numeric format - DO NOT USE)

Month Abbreviations (4+ letters): - Jan., Feb., Aug., Sept., Oct., Nov., Dec. - Do NOT
abbreviate: May, June, July

Title Guidelines: - Center on page - Double-space from date - Title Case: Capitalize major
words - NO special formatting (bold/italics/underline) on YOUR title - If your title includes
another work, format that: - Books, films: italics (Symbolism in The Great Gatsby) -
Poems, articles: quotes (Analysis of “The Road Not Taken”)

HEADER (EVERY PAGE)
Format: - Last name + space + page number - Top right corner - 0.5 inch from top edge -
Same font as body text - Continue on EVERY page including Works Cited

Setting up in Word: 1. Insert → Header → Blank 2. Type last name + space 3. Insert →
Page Number → Current Position → Plain Number 4. Right-align 5. Close header

IN-TEXT CITATIONS

BASIC FORMAT

Author named in sentence:

Fitzgerald describes the light as "minute and far away" (21).

Author in parentheses:

The green light appears "minute and far away" (Fitzgerald 21).

KEY RULES: - Format: (Author page) - NO comma between author and page - NO “p.”
or “pp.” before page number - Period comes AFTER parentheses - If author named in
sentence, only page number in parentheses

AUTHOR VARIATIONS

One author:

(Smith 45)
Smith argues that... (45)

Two authors:

(Smith and Jones 45)
Smith and Jones argue... (45)

Use “and” not “&”

Three or more authors:

(Smith et al. 45)

“et al.” = “and others”
Include period after “al”

No author:

("Article Title" 12)

Use shortened title



Article titles in quotes
Book/website titles italicized

Corporate/Organization author:

(American Medical Association 34)

First use: Full name
Later: Can abbreviate if clear (AMA 34)

QUOTES

Short quotes (4 lines or less):

According to Fitzgerald, the light is "minute and far away" (21).

Long quotes (more than 4 lines of prose OR 3+ lines of poetry): - Called “block
quotes” - Start on new line - Indent entire quote 1 inch from left margin - Double-space -
NO quotation marks - Citation AFTER final punctuation

Example:

Fitzgerald describes the valley:
     This is a valley of ashes—a fantastic farm where 
     ashes grow like wheat into ridges and hills and 
     grotesque gardens; where ashes take the forms of 
     houses and chimneys. (23)

Poetry (3+ lines): - Maintain original line breaks - Indent 1 inch

     Because I could not stop for Death –
     He kindly stopped for me –
     The Carriage held but just Ourselves –
     And Immortality. (Dickinson 1-4)

Poetry (1-2 lines) in text:

Dickinson writes, "Because I could not stop for Death – / He kindly 
stopped for me –" (1-2).

Use forward slash with spaces (/) to show line breaks

SPECIAL CITATIONS

No page numbers (websites, e-books):

(Author)

Omit page number completely

Paragraph numbers:

(Author par. 5)
(Author pars. 5-7)

Section headings:

(Author, sec. 3)

Multiple works by same author:

(Fitzgerald, Gatsby 21)
(Fitzgerald, Tender 45)

Include shortened title
Italics for books, quotes for articles

Indirect source (citing something quoted in your source):

Hemingway stated "..." (qtd. in Smith 45)



“qtd. in” = “quoted in”
Avoid when possible - find original

Multiple sources:

(Smith 45; Jones 78; Williams 90)

Semicolons separate sources
Alphabetical order

Literary works:

Novels with chapters:

(Fitzgerald 21; ch. 3)

Helps readers with different editions

Plays (Act.Scene.Line):

(Hamlet 3.2.115-120)

Example: Act 3, Scene 2, Lines 115-120

Poems (line numbers):

(Wordsworth lines 1-4)  ← first reference
(1-4)                   ← later references

Bible (Book Chapter.Verse):

(John 3.16)

WORKS CITED PAGE

BASIC FORMAT

Page Setup: - New page after essay ends - Header continues (Last name Page#) - Title:
“Works Cited” centered, NO bold/italics/underline - Double-spaced throughout - Hanging
indent: First line flush left, rest indented 0.5 inch - Alphabetical by author’s last name (or
title if no author)

General Pattern:

Author. Title. Container, Other Contributors, Version, 
     Number, Publisher, Publication Date, Location.

PUNCTUATION RULES

Periods separate major elements
Commas separate elements within sections
End each entry with period

Capitalization: - Author names: As they appear - Titles: Title Case (capitalize all major
words)

AUTHOR FORMATS
One author:

Last name, First name.

Two authors:



Last name, First name, and First name Last name.

Note: First author reversed, second in normal order

Three or more authors:

Last name, First name, et al.

List only first author + “et al.”

Corporate/Organization author:

Organization Name.

Editor as author:

Last name, First name, editor.

OR for multiple editors:

Last name, First name, and First name Last name, editors.

No author: - Start with title - Alphabetize by first major word (ignore A, An, The)

TITLE FORMATTING

ITALICIZE (independent works):

Books
Journals, magazines, newspapers
Websites
Films, TV series
Albums
Plays (published as books)
Long poems (published as books)
Pamphlets

QUOTATION MARKS (parts of larger works):

Articles
Book chapters
Short stories
Poems (not book-length)
Essays
Song titles
TV episodes
Web pages (on a website)

EXAMPLES:

Book: The Great Gatsby
Article: “Understanding Gatsby”
Website: SparkNotes
Webpage: “The American Dream”
Journal: American Literature Review
Article in journal: “Symbolism in Modernist Fiction”

WORKS CITED EXAMPLES BY SOURCE TYPE

BOOKS



Basic book:

Author. Book Title. Publisher, Year.

Fitzgerald, F. Scott. The Great Gatsby. Scribner, 2004.

Book with edition:

Author. Book Title. Edition number, Publisher, Year.

Strunk, William, and E. B. White. The Elements of Style. 
     4th ed., Longman, 1999.

Edited book:

Editor, First name, editor. Book Title. Publisher, Year.

Smith, John, editor. American Literature Essays. 
     Oxford UP, 2023.

Book chapter/essay:

Author. "Chapter Title." Book Title, edited by First name 
     Last name, Publisher, Year, pp. page-page.

Pelzer, Linda. "The American Dream in Gatsby." Student 
     Companion to F. Scott Fitzgerald, Greenwood Press, 
     2000, pp. 57-71.

Translated book:

Author. Book Title. Translated by First name Last name, 
     Publisher, Year.

Camus, Albert. The Stranger. Translated by Matthew Ward, 
     Vintage, 1989.

E-book:

Author. Book Title. E-book ed., Publisher, Year.

Fitzgerald, F. Scott. The Great Gatsby. E-book ed., 
     Scribner, 2004.

Audiobook:

Author. Book Title. Narrated by First name Last name, 
     Publisher, Year. Audible.

Fitzgerald, F. Scott. The Great Gatsby. Narrated by 
     Jake Gyllenhaal, Audible Studios, 2013. Audible.

ARTICLES

Journal article (print):

Author. "Article Title." Journal Title, vol. number, 
     no. number, Year, pp. page-page.

Smith, John. "Symbolism in Gatsby." American Literature 
     Review, vol. 45, no. 2, 2023, pp. 123-145.

Journal article (online with DOI):

Author. "Article Title." Journal Title, vol. number, 
     no. number, Year, pp. page-page., DOI.

Jones, Mary. "The American Dream Deferred." Journal of 
     American Studies, vol. 52, no. 3, 2022, pp. 234-256., 
     doi:10.1093/jas/xyz123.

Journal article (online with URL):



Author. "Article Title." Journal Title, vol. number, 
     no. number, Year, pp. page-page., URL.

Williams, Sarah. "Fitzgerald's Legacy." Modern Fiction 
     Studies, vol. 67, no. 1, 2021, pp. 45-67., 
     muse.jhu.edu/article/789123.

Magazine article:

Author. "Article Title." Magazine Title, Day Month Year, 
     pp. page-page.

Brown, David. "Gatsby at 100." The New Yorker, 
     10 Apr. 2025, pp. 34-39.

Newspaper article:

Author. "Article Title." Newspaper Title, Day Month Year, 
     pp. page-page.

Martinez, Ana. "Rereading American Classics." The New York 
     Times, 15 May 2024, pp. C1-C3.

Article from database:

Author. "Article Title." Journal Title, vol. number, 
     no. number, Year, pp. page-page. Database Name, URL.

Garcia, Robert. "Modernist Symbolism." Contemporary 
     Literature, vol. 55, no. 4, 2020, pp. 678-702. 
     JSTOR, www.jstor.org/stable/12345678.

WEBSITES

Entire website:

Website Title. Publisher/Sponsor, Year, URL.

SparkNotes. SparkNotes LLC, 2024, www.sparknotes.com.

Web page:

Author. "Page Title." Website Title, Publisher, 
     Day Month Year, URL.

"The American Dream." SparkNotes, SparkNotes LLC, 
     2024, www.sparknotes.com/lit/gatsby/themes/.

Web page, no author:

"Page Title." Website Title, Publisher, Day Month Year, 
     URL.

"Understanding Symbolism." Literary Devices, 
     literarydevices.net, 12 Jan. 2024, 
     www.literarydevices.net/symbolism/.

Web page, no date:

Author. "Page Title." Website Title, URL. Accessed 
     Day Month Year.

Smith, John. "Gatsby Analysis." American Lit Online, 
     www.amlit.com/gatsby. Accessed 15 May 2024.

Blog post:

Author. "Post Title." Blog Name, Day Month Year, URL.

Johnson, Emily. "Why Gatsby Still Matters." The Literary 
     Blog, 20 Mar. 2024, literaryblog.com/gatsby-matters.



MULTIMEDIA

Film:

Title. Directed by First name Last name, Distributor, Year.

The Great Gatsby. Directed by Baz Luhrmann, Warner Bros., 
     2013.

Film (focus on specific contributor):

Contributor role. Title. Directed/Performed by names, 
     Distributor, Year.

DiCaprio, Leonardo, performer. The Great Gatsby. Directed 
     by Baz Luhrmann, Warner Bros., 2013.

TV episode:

"Episode Title." TV Series Title, season number, 
     episode number, Network, Day Month Year.

"The One Where..." Friends, season 5, episode 14, NBC, 
     11 Feb. 1999.

YouTube video:

Username or Author. "Video Title." YouTube, Day Month Year, 
     URL.

CrashCourse. "The Great Gatsby - Thug Notes Summary." 
     YouTube, 15 June 2014, www.youtube.com/watch?v=xxxxx.

Podcast episode:

"Episode Title." Podcast Name, hosted by Host name, 
     season/episode numbers, Publisher, Day Month Year, 
     URL.

"Understanding Gatsby." The Literary Podcast, hosted by 
     Sarah Jones, season 2, episode 5, NPR, 10 Jan. 2024, 
     www.npr.org/podcast/episode.

Song:

Artist. "Song Title." Album Title, Label, Year.

Lana Del Rey. "Young and Beautiful." The Great Gatsby 
     Soundtrack, Interscope, 2013.

Music streaming:

Artist. "Song Title." Album Title, Label, Year. 
     Streaming Service, URL.

Lana Del Rey. "Young and Beautiful." The Great Gatsby 
     Soundtrack, Interscope, 2013. Spotify, 
     open.spotify.com/track/xxxxx.

SOCIAL MEDIA

Twitter/X post:

Author/Handle. "Full text of tweet." Twitter, 
     Day Month Year, Time, URL.

@LiteraryQuotes. "The Great Gatsby remains one of 
     literature's finest examinations of the American 
     Dream." Twitter, 10 Apr. 2024, 2:30 p.m., 
     twitter.com/user/status/xxxxx.



Instagram post:

Author. "First 20 words or description..." Instagram, 
     Day Month Year, URL.

@bookstagram. "Just finished Gatsby for the third time..." 
     Instagram, 5 May 2024, www.instagram.com/p/xxxxx.

Facebook post:

Author. "Post text or description." Facebook, 
     Day Month Year, URL.

OTHER SOURCES

Personal interview (conducted by you):

Interviewee name. Personal interview. Day Month Year.

Smith, Professor John. Personal interview. 15 May 2024.

Published interview:

Interviewee. "Interview Title." Interview by Interviewer 
     name. Publication, Day Month Year, pp./URL.

Fitzgerald, F. Scott. "An Interview with F. Scott 
     Fitzgerald." Interview by Charles C. Baldwin. 
     The Paris Review, Spring 1925, pp. 23-34.

Lecture/Speech:

Speaker. "Presentation Title." Sponsoring Organization, 
     Day Month Year, Location.

Martinez, Dr. Ana. "Symbolism in American Literature." 
     Modern Language Association Annual Convention, 
     7 Jan. 2024, Chicago.

Email:

Sender. "Subject Line." Received by Your name, 
     Day Month Year.

Smith, Professor John. "Re: Essay Question." Received by 
     Sarah Chen, 10 May 2024.

Dissertation/Thesis:

Author. Title. Year. Institution, Degree type dissertation.

Johnson, Emily. The Evolution of the American Dream in 
     20th Century Literature. 2023. Stanford U, 
     PhD dissertation.

Government document:

Government Body. Title. Publisher, Year, URL if online.

United States, Department of Education. Education 
     Statistics Annual Report. Government Printing 
     Office, 2023.

SPECIAL FORMATTING SITUATIONS

MULTIPLE WORKS BY SAME AUTHOR

List chronologically (earliest first):



Fitzgerald, F. Scott. The Great Gatsby. Scribner, 1925.
---. Tender Is the Night. Scribner, 1934.
---. The Last Tycoon. Scribner, 1941.

Use three hyphens (—) followed by period for repeated author
If same year, alphabetize by title

NO PAGE NUMBERS

For sources without page numbers: - Omit page numbers from in-text citations - Just
use (Author) - Common for websites, e-books, videos

SHORTENED TITLES

When title is long: - Use first major word or two - Maintain formatting (italics or quotes)
- Example: The Great Gatsby → Gatsby - Example: “Understanding Modern American
Literature” → “Understanding”

FORMATTING TIPS & TRICKS

SETTING UP YOUR DOCUMENT

Before you start writing:

1. Set margins: 1 inch all sides
2. Choose font: Times New Roman 12pt
3. Set spacing: Double-space (2.0)
4. Set paragraph indent: 0.5 inch first line
5. Create header: Last name + auto page number
6. Type heading: Name, professor, course, date
7. Center title: Type title, center it

USING HANGING INDENT (WORKS CITED)

In Microsoft Word: 1. Select all Works Cited entries 2. Right-click → Paragraph 3.
Indentation → Special → Hanging 4. Set to 0.5 inch 5. Click OK

OR

1. Select entries
2. Press Ctrl + T (Windows) or Cmd + T (Mac)

In Google Docs: 1. Select entries 2. Format → Align & indent → Indentation options 3.
Special indent → Hanging 4. Set to 0.5 inch

QUICK KEYBOARD SHORTCUTS

Indentation: - Tab = First line indent (0.5 inch) - Ctrl + T = Hanging indent

Formatting: - Ctrl + B = Bold - Ctrl + I = Italics - Ctrl + U = Underline - Ctrl + E = Center
- Ctrl + L = Left align

GRAMMAR & STYLE FOR LITERARY
ANALYSIS

VERB TENSE

Present tense for discussing literature:



✓ Fitzgerald describes the green light...
✓ The symbol represents hope...
✓ Gatsby believes in the dream...

✗ Fitzgerald described...
✗ The symbol represented...

Past tense for historical context:

✓ Fitzgerald published Gatsby in 1925.
✓ The novel was written during Prohibition.

TITLES IN TEXT

Referring to authors: - First reference: Full name (F. Scott Fitzgerald) - Subsequent: Last
name only (Fitzgerald) - NOT: Fitzgerald, F. Scott or Mr. Fitzgerald

Referring to titles: - Full title, properly formatted - The Great Gatsby (not “The Great
Gatsby” or The Great Gatsby)

INTEGRATING QUOTES

Use signal phrases:

✓ According to Fitzgerald,...
✓ The narrator explains that...
✓ As Gatsby reveals,...
✓ Fitzgerald writes,...

Avoid “says”:

Better alternatives: writes, states, argues, suggests, 
claims, asserts, explains, demonstrates, reveals

COMMON MLA ERRORS TO AVOID
� Creating separate title page (not used in MLA) � Including “p.” or “pp.” in citations:
(Smith p. 45) � Using comma in citations: (Smith, 45) � Wrong date format: May 15,
2024 (should be 15 May 2024) � Using “&” instead of “and”: Smith & Jones �
Bold/italics on your title � Extra spaces between paragraphs � Not indenting paragraphs �
Forgetting header on Works Cited page � Not using hanging indent for Works Cited �
“Bibliography” instead of “Works Cited” � Alphabetizing by first name instead of last �
Including “http://” or “https://” in URLs (omit these) � Underlining instead of italicizing
titles � Not double-spacing Works Cited entries

PRE-SUBMISSION CHECKLIST
FORMATTING: ☐ Times New Roman 12pt (or approved font) ☐ 1-inch margins all
sides ☐ Double-spaced throughout (no extra spaces) ☐ Header on every page (last name
+ page number) ☐ First line of paragraphs indented 0.5 inch

FIRST PAGE: ☐ Heading in top left (name, professor, course, date) ☐ Date format: Day
Month Year ☐ Title centered, standard formatting ☐ No separate title page

IN-TEXT CITATIONS: ☐ All quotes/paraphrases cited ☐ Format: (Author page) - no
comma, no “p.” ☐ Period after parentheses ☐ Present tense for discussing literature

WORKS CITED: ☐ New page with header ☐ “Works Cited” centered ☐ Hanging indent
for all entries ☐ Double-spaced ☐ Alphabetical order ☐ All sources properly formatted ☐
Every in-text citation has Works Cited entry ☐ Every Works Cited entry is cited in paper

CONTENT: ☐ Clear thesis statement ☐ Strong topic sentences ☐ Analysis, not summary



☐ Proper quote integration ☐ Proofread for errors

HELPFUL RESOURCES
Official MLA Resources: - MLA Handbook (9th edition) - MLA Style Center:
style.mla.org - MLA formatting videos - Purdue OWL
(owl.purdue.edu/owl/research_and_citation/mla_style/)

Citation Generators (ALWAYS VERIFY): - EasyBib - Citation Machine - BibMe -
Zotero (free, most reliable)

Note: Citation generators make mistakes. Always double-check against MLA Handbook.

WHEN IN DOUBT
1. Check MLA Handbook (9th ed.) - Official source
2. Ask your instructor - May have preferences
3. Purdue OWL - Excellent free resource
4. Be consistent - Pick one format and stick to it
5. Cite everything - When unsure, cite it

PRINT THIS CHEAT SHEET FOR QUICK REFERENCE WHILE WRITING!

Remember: This is a quick reference guide. For comprehensive rules and unusual
situations, always consult the MLA Handbook (9th edition).
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